## Contents

### About This User Guide
- How to Find Information
- How to Contact Altera
- Typographic Conventions

### Getting Started
- Introduction
- Before You Begin
  - Nios Development Board and Accessories
  - Development Tools
  - Documentation
- Licensing Considerations
- Installing the Development Tools
  - The Quartus II Design Software
  - The Nios II Embedded Design Suite
  - The MegaCore IP Library
- The Nios Development Board
  - Setting Up the Nios Development Board
  - Verifying Correct Operation of the Nios Development Board
- Establishing Board-to-PC Communication
  - Connecting the USB-Blaster Download Cable
- Starting the Nios II Development Tools
  - Starting the Quartus II Software
  - Downloading a Hardware Image to the FPGA
  - Starting the Nios II IDE from SOPC Builder
  - Building a First Software Project
  - Downloading Executable Code to the Nios Development Board
- Taking the Next Step
- Documentation Library

---

Altera Corporation
About This User Guide

This getting started user guide provides initial information about how to use the Altera® Nios® II development kit, including unpacking the kit, installing required software, connecting the Nios development board to a PC, and running sample software.

The “User Guide Revision History” table shows this document’s revision history.

Refer to the Nios II embedded processor readme file for late-breaking information that is not available in this document.

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>May 2007</td>
<td>Updates for the Nios II development kit version 7.1.</td>
</tr>
<tr>
<td>March 2007</td>
<td>Updates for the Nios II development kit version 7.0.</td>
</tr>
<tr>
<td>December 2006</td>
<td>Updates for the Nios II development kit version 6.1.</td>
</tr>
<tr>
<td>May 2006</td>
<td>Updates for the Nios II development kit version 6.0.</td>
</tr>
<tr>
<td>October 2005</td>
<td>Updates for the Nios II development kit version 5.1.</td>
</tr>
<tr>
<td>May 2005</td>
<td>Updates for the Nios II development kit version 5.0.</td>
</tr>
<tr>
<td>December 2004</td>
<td>Updates for the Nios II development kit version 1.1.</td>
</tr>
<tr>
<td>September 2004</td>
<td>Updates for the Nios II development kit version 1.01.</td>
</tr>
<tr>
<td>May 2004</td>
<td>Initial publication for the Nios II development kit version 1.0.</td>
</tr>
</tbody>
</table>

How to Find Information

- The Adobe Acrobat Find feature allows you to search the contents of a PDF file. Click the binoculars toolbar icon to open the Find dialog box
- Bookmarks serve as an additional table of contents
- Thumbnail icons, which provide miniature previews of each page, provide a link to the pages
- Numerous links, shown in green text, allow you to jump to related information
How to Contact Altera

For the most up-to-date information about Altera products, refer to the following table.

<table>
<thead>
<tr>
<th>Contact (1)</th>
<th>Contact Method</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical support</td>
<td>Website</td>
<td><a href="http://www.altera.com/support">www.altera.com/support</a></td>
</tr>
<tr>
<td>Technical training</td>
<td>Website</td>
<td><a href="http://www.altera.com/training">www.altera.com/training</a></td>
</tr>
<tr>
<td>Product literature</td>
<td>Email</td>
<td><a href="mailto:custrain@altera.com">custrain@altera.com</a></td>
</tr>
<tr>
<td>Altera literature services</td>
<td>Email</td>
<td><a href="mailto:literature@altera.com">literature@altera.com</a></td>
</tr>
<tr>
<td>Non-technical support (General)</td>
<td>Email</td>
<td><a href="mailto:nacomp@altera.com">nacomp@altera.com</a></td>
</tr>
<tr>
<td>(Software Licensing)</td>
<td>Email</td>
<td><a href="mailto:authorization@altera.com">authorization@altera.com</a></td>
</tr>
</tbody>
</table>

*Note to table:*
(1) You can also contact your local Altera sales office or sales representative.

Typographic Conventions

This document uses the typographic conventions shown below.

<table>
<thead>
<tr>
<th>Visual Cue</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold Type with Initial Capital Letters</strong></td>
<td>Command names, dialog box titles, checkbox options, and dialog box options are shown in bold, initial capital letters. Example: <em>Save As</em> dialog box.</td>
</tr>
<tr>
<td><strong>bold type</strong></td>
<td>External timing parameters, directory names, project names, disk drive names, filenames, filename extensions, and software utility names are shown in bold type. Examples: <em>f.MAX</em>, <em>\qdsgn</em> directory, <em>d:</em> drive, <em>chiptrip.gdf</em> file.</td>
</tr>
<tr>
<td><strong>Italic Type with Initial Capital Letters</strong></td>
<td>Document titles are shown in italic type with initial capital letters. Example: <em>AN 75: High-Speed Board Design.</em></td>
</tr>
<tr>
<td><strong>Italic type</strong></td>
<td>Internal timing parameters and variables are shown in italic type. Examples: <em>t_{PIA}, n + 1.</em></td>
</tr>
<tr>
<td></td>
<td>Variable names are enclosed in angle brackets (<em>&lt;&gt;</em>) and shown in italic type. Example: <em>&lt;filename&gt;, &lt;project name&gt;.pof</em> file.</td>
</tr>
<tr>
<td><strong>Initial Capital Letters</strong></td>
<td>Keyboard keys and menu names are shown with initial capital letters. Examples: Delete key, the Options menu.</td>
</tr>
<tr>
<td><strong>“Subheading Title”</strong></td>
<td>References to sections within a document and titles of on-line help topics are shown in quotation marks. Example: “Typographic Conventions.”</td>
</tr>
<tr>
<td>Visual Cue</td>
<td>Meaning</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Courier type</td>
<td>Signal and port names are shown in lowercase Courier type. Examples: data1, tdi, input. Active-low signals are denoted by suffix n, e.g., resetn. Anything that must be typed exactly as it appears is shown in Courier type. For example: c:\qdesigns\tutorial\chiptrip.gdf. Also, sections of an actual file, such as a Report File, references to parts of files (e.g., the AHDL keyword SUBDESIGN), as well as logic function names (e.g., TRI) are shown in Courier.</td>
</tr>
<tr>
<td>1., 2., 3., and a., b., c., etc.</td>
<td>Numbered steps are used in a list of items when the sequence of the items is important, such as the steps listed in a procedure.</td>
</tr>
<tr>
<td>■ • •</td>
<td>Bullets are used in a list of items when the sequence of the items is not important.</td>
</tr>
<tr>
<td>☑</td>
<td>The checkmark indicates a procedure that consists of one step only.</td>
</tr>
<tr>
<td><img src="hand.png" alt="hand" /></td>
<td>The hand points to information that requires special attention.</td>
</tr>
<tr>
<td><img src="caution.png" alt="caution" /></td>
<td>A caution calls attention to a condition or possible situation that can damage or destroy the product or the user's work.</td>
</tr>
<tr>
<td><img src="warning.png" alt="warning" /></td>
<td>A warning calls attention to a condition or possible situation that can cause injury to the user.</td>
</tr>
<tr>
<td><img src="enter.png" alt="enter" /></td>
<td>The angled arrow indicates you should press the Enter key.</td>
</tr>
<tr>
<td><img src="feet.png" alt="feet" /></td>
<td>The feet direct you to more information on a particular topic.</td>
</tr>
</tbody>
</table>
Introduction

Welcome to the Nios® II development kit! The Nios II development kit is a complete embedded systems development kit for the Nios II embedded processor. In addition to the full-featured Nios development board, the kit includes all the hardware and software development tools, documentation and accessories you need to begin developing Nios II embedded processor systems.

This user guide will familiarize you with the contents of the Nios II development kit and walk you through setting up your Nios II development environment. In this guide, you will:

1. Install the development tools software.
2. Set up and verify correct operation of the Nios development board.
3. Establish communication between the Nios development board and the host PC.
4. Compile C code and download the code to the Nios development board.

When you finish this guide, you will be ready to begin designing custom Nios II embedded processor systems.

Before You Begin

Before proceeding, check the contents of the kit and verify that you received the items described in this section.

Nios Development Board and Accessories

- Nios development board
- USB-Blaster™ download cable
- Ethernet cable
- Ethernet cross-over adapter
- Ethernet PHY daughter board
- LCD module
- 9-pin RS-232 serial cable
- DC power supply
- Three regional power cables
Licensing Considerations

Development Tools

Included in the kit is a folder containing the Altera Complete Design Suite for Windows DVD-ROM.

See www.altera.com for available evaluation software by third-party Nios II development partners.

Documentation

- This Nios II Development Kit Getting Started User Guide
- Quartus® II Installation & Licensing for Windows manual

Installing the Development Tools

Your PC system must meet the Quartus II software minimum system requirements. Refer to the Altera Complete Design Suite System Requirements section of the Quartus II Installation & Licensing for Windows manual (included in the kit) for system requirements.

The Altera Complete Design Suite for Windows DVD-ROM contains all the software necessary for the kit. Refer to the Installing the Altera Complete Design Suite section of the Quartus II Installation & Licensing for Windows manual and install at least the following tools:

- Quartus® II Design Software
- MegaCore® IP Library
- Nios II Embedded Design Suite

The Quartus II Design Software

The Nios II Embedded Design Suite (EDS) requires the Quartus II Design Software. The Quartus II design software is Altera’s comprehensive environment for system-on-a-programmable-chip (SOPC) hardware design. Using the Quartus II software, you can develop hardware design files, synthesize a netlist for the design, and output a configuration file for the target FPGA. You use the Quartus II software to assign I/O pin numbers, apply compilation constraints (for example, timing requirements), and perform timing analysis on the FPGA design. The Quartus II software installation also includes the SOPC Builder system.
integration tool and embedded peripherals you can integrate into Nios II processor systems. You use SOPC Builder to define and integrate Nios II processor-based hardware systems.

To use the Quartus II software included in your kit, you must first obtain a license file. A one-year license for the Quartus II software is included with your purchase of this kit. For details on how to obtain your license see “Licensing Considerations” on page 1–2.

Install and license the Quartus II software as described in the Quartus II Installation & Licensing for Windows manual. The manual is included in your kit and is also available on the Quartus II literature page, http://www.altera.com/literature/lit-qts.jsp.

You need administrative privileges to install parts of the Quartus II software on Windows XP, Windows 2000, and Linux.

The Nios II Embedded Design Suite

The Nios II Embedded Design Suite contains the tools listed below:

- **Nios II Integrated Development Environment (IDE)** – The Nios II IDE is the software development interface for the Nios II processor. All software development tasks can be accomplished within the Nios II IDE, including creating, editing, compiling, and debugging programs.

- **GNU toolchain** – The Nios II compiler tool chain is based on the standard GNU GCC compiler, assembler, linker, and makefile facilities.

To create new Nios II hardware designs, you must first obtain a Nios II embedded processor license. A one-year subscription for the Nios II embedded processor is included with the purchase of this kit. For details on how to obtain your license, see section “Licensing Considerations” on page 1–2. Using the Nios II IDE and the software development tool chain does not require a license. Therefore, you do not need a license if you will only develop software for the Nios II processor.

The MegaCore IP Library

The MegaCore IP Library is a library of ready-made intellectual property (IP) cores that are optimized for Altera devices. The MegaCore IP Library contains the Nios II CPU hardware component and peripheral components, including a DDR SDRAM controller.
The license for the Nios II Development Kit, Cyclone II Edition and Stratix II Edition includes a license for the DDR SDRAM Controller MegaCore. The other cores in the MegaCore IP Library are fully functional for evaluation, but have a timeout feature. You must purchase a full license to ship a product that includes any other MegaCores.

The Nios Development Board

The Nios development board will be your steady companion through much of your development effort with the Nios II processor. Hardware designers can use the Nios development board as a platform to prototype complex embedded systems. Software developers can use the Nios II reference design preprogrammed on the development board to begin prototyping software immediately.

The Nios development board comes pre-configured with a Nios II processor hardware reference design and a software reference design stored in flash memory.

For complete details on the Nios development board, refer to the appropriate Nios Development Board Reference Manual.

Setting Up the Nios Development Board

First, you will set up the Nios development board. The Nios development board will show activity to verify that it is alive and functioning correctly. Figure 1–1 shows a Nios Development Board, Cyclone II Edition with the power cable, LCD module, and USB Blaster cable attached. For all Nios development boards, the relative location and orientation of the cables is the same.
To set up the Nios development board, perform the following steps:

1. Remove the Nios development board from its anti-static shipping bag. Take care not to expose the board to electrostatic discharge (ESD) during setup or use.

2. Place the board legs-down on a flat surface. Orient the board as shown in Figure 1-1 with the dual 7-segment LEDs (U8 and U9) closest to you.

3. Connect the LCD module ribbon cable to connector J12, as shown in Figure 1–1.

   Be sure to connect pin 1 on the LCD module to pin 1 of J12 by aligning the triangular marks on the ribbon cable header with the locations of pin 1 on the LCD module and the J12 header. Pin 1 of the J12 header is labeled on the printed circuit board.
Connecting the LCD module to any other connector will damage the LCD module. Do not mistake J12 with the similar J15 at the bottom edge of the board.

4. Connect the DC power-supply to connector J26, as shown in Figure 1–1 on page 1–5. Select the appropriate power cord for your geographic region. Connect one end to the DC power supply and the other end to a power outlet.

Verifying Correct Operation of the Nios Development Board

You will see activity on the board after applying power. As soon as you apply power to the Nios development board, the Altera FPGA is configured with a Nios II processor hardware reference design. Once the FPGA configuration is complete, the Nios II processor in the FPGA wakes up, initializes itself with boot code from flash memory, and displays “Nios II” on the LCD for 10 seconds, followed by scrolling instructions for a web server demo. You can connect the board to an Ethernet network and view web pages served from the web server reference design.

Verify the following indicators of a properly functioning Nios development board:

- The power LED (LED5) is on. LED5 is located under the Altera logo near the top-right corner of the board.
- The LED labeled “Safe” or “Factory” is on.
- The two 7-segment LEDs are active, displaying a spinning pattern.
- The LEDs D0 – D7 are active, displaying a bouncing pattern.
- The LCD displays “Nios II”.

The LCD screen might not function if a CompactFlash card is seated in the CompactFlash socket.

If you are not the first user of your Nios development board, the board might no longer contain the original factory image programmed in flash memory. In this case, you will not see the same indicators noted above. The LED labeled User might be on or flashing, indicating that the development board is programmed with another designer’s user image.

If you want to reprogram your board to its factory default condition, refer to the appropriate Nios Development Board Reference Manual.

If this is the first time you are applying power to the Nios development board and you do not see the indicators above, check all the connections and make sure that power is supplied to the board properly. For further assistance visit Altera’s online technical support web site at mysupport.altera.com.
Establishing Board-to-PC Communication

In this section, you will connect the Nios development board to your PC via a USB cable to establish communication with the development board.

Connecting the USB-Blaster Download Cable

Connect your USB-Blaster download cable to the Nios development board as instructed below.

1. Remove power from the Nios development board by disconnecting the power cable.

2. Connect one end of the USB cable to the USB port on your PC. Connect the other end to the USB-Blaster download cable.

3. Connect the USB-Blaster download cable to the 10-pin header J24 on the Nios development board so that it extends upward away from you. Pin 1, which is marked on the ribbon cable, should align with the pin 1 label on the board. See Figure 1–1 on page 1–5.

4. Re-apply power to the Nios development board.

5. Install the USB Blaster driver on the host computer. The driver is located in the directory `<Quartus II software install path>\drivers\usb-blaster`.

For details on installing the USB-Blaster driver for Windows, see the USB Blaster Download Cable User Guide at www.altera.com.

Starting the Nios II Development Tools

Once you have connected your Nios development board to your computer, you can start the Nios II IDE from the Quartus II software.

Starting the Quartus II Software

Start the Quartus II software and open a Nios II project by performing the following steps:

1. Launch the Quartus II software.

   a. On the Windows Start menu point to All Programs, Altera, Quartus II <version>, and then click Quartus II <version>.

   b. If prompted about software updates, click Yes to get updates automatically from the Altera web site.

   c. If prompted to create a new project, click No.
2. When the Quartus II window appears, on the File menu, click Open Project.

Be sure to choose Open Project and not Open.

3. Browse to the directory `<Nios EDS install path>\examples\verilog\niosII_<board type>\standard` for your board. Replace `niosII_<board type>` with a directory name shown in Table 1–1.

<table>
<thead>
<tr>
<th>Nios Development Board</th>
<th>Directory Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stratix II Edition</td>
<td>niosII_stratixII_2s60 or niosII_stratixII_2s60_es</td>
</tr>
<tr>
<td>Stratix Edition</td>
<td>niosII_stratix_1s10 or niosII_stratix_1s10_es</td>
</tr>
<tr>
<td>Cyclone II Edition</td>
<td>niosII_cycloneII_2c35</td>
</tr>
<tr>
<td>Cyclone Edition</td>
<td>niosII_cyclone_1c20</td>
</tr>
<tr>
<td>Stratix Professional Edition</td>
<td>niosII_stratixI_1s40</td>
</tr>
</tbody>
</table>

4. Select the file `<directory name>_standard.qpf` and click Open. The `<directory name>_standard.qpf` file contains project definitions for the example design used in this getting started user guide.

For example, the Nios II Development Kit, Stratix Edition, Quartus II project file is located at `<Nios EDS install path>\examples\verilog\niosII_cyclone_2c35\standard\NiosII_cyclone_2c35_standard.qpf`.

You can use the vhdl directory instead of the verilog directory, if you prefer the VHDL language.

**Downloading a Hardware Image to the FPGA**

To download the Nios II SRAM Object File (.sof) image to the Nios development board, follow these steps:

1. On the Tools menu, click Programmer.

2. Click Hardware Setup.

3. Select USB-Blaster in the Currently selected hardware list and click Close.

4. Turn on Program/Configure, located on the same row as `<directory name>_standard.sof`. 
5. Click **Start**.

Upon download success, the Messages window will display “Info: successfully performed operation(s).” If you do not see this message, check your cable connections and the Quartus II Programmer hardware setup.

**Starting the Nios II IDE from SOPC Builder**

Now that you have configured the FPGA with a Nios II system, you can proceed to the Nios II IDE to download software to the processor.

To start the Nios II IDE, perform the following steps:

1. On the Tools menu in the Quartus II software, click **SOPC Builder**.

2. When the SOPC Builder window opens, click on the **System Generation** tab.

3. Click **Nios II IDE** to start the Nios II IDE. See **Figure 1–2**.

   ![Figure 1–2. Starting the Nios II IDE from SOPC Builder](image)

   In the future, you can launch the Nios II IDE directly without running the Quartus II software. On the Windows Start menu point to **All Programs, Altera, Nios II EDS <version>**, and then click **Nios II <version> IDE**.
4. If the **Workspace Launcher** dialog box displays when the Nios II IDE starts, click **OK** to accept the default workspace directory.

5. If this is not the first time you are running the Nios II IDE, look for the highlighted **Nios II C/C++** button on the perspective’s tab (see upper-right portion of Figure 1–5) to verify that you are using the Nios II C/C++ perspective. If you are not using the Nios II C/C++ perspective, point to **Open Perspective** on the Window menu, and then either click **Nios II C/C++**, or click **Other...** and then double-click **Nios II C/C++**.

**Building a First Software Project**

To create a simple **Hello World** project, perform the following steps:

1. On the File menu, point to **New**, and then click **Nios II C/C++ Application**. The New Project wizard for Nios II C/C++ applications appears. See Figure 1–3.
2. Select **Hello World** in the **Select Project Template** list.

3. Click **Finish** to create the project named **hello_world_0**. This process also creates a system library project named **hello_world_0_syslib**.

4. In the Nios II C/C++ Projects view, right-click the **hello_world_0** project, and then click **Build Project**.

When the build finishes, the Console view at the bottom of the workbench displays the message “Build completed in <number> seconds.” If the Console view is not visible, click the **Console** tab.
Starting the Nios II Development Tools

Downloading Executable Code to the Nios Development Board

From the Nios II IDE, perform the following steps to download executable code and run it on the board.

1. On the Run menu, click Run.... The Run dialog box appears.

2. Right-click Nios II Hardware in the configurations list, and then click New.

3. Click the Target Connection tab.

4. From the JTAG cable list, select USB-Blaster. In a moment, the Run button becomes active. See Figure 1–4.

   Figure 1–4. Run Dialog in the Nios II IDE

5. Click Run at the bottom of the dialog box. The hello_world_0 software image downloads to the Nios development board and begins running.
"Hello from Nios II!" appears in the Console view of the Nios II IDE. See Figure 1–5. If the Console view is not visible, click on the Console tab to bring it to the foreground.

Figure 1–5. "Hello World" in the Nios II IDE Console View

Congratulations! You have completed the first steps to familiarize yourself with the Nios II Development Kit. If you completed all of the steps above, then you have installed your Nios II development environment, and verified that the Nios development board and tools function correctly.
Taking the Next Step

To learn more about the Nios II embedded processor, hardware designers can start with the Nios II Hardware Development Tutorial. Software developers can start with the Nios II Software Development Tutorial available within the Nios II IDE help system. These tutorials introduce you to the development process for the Nios II embedded processor. Each tutorial uses the Nios development board as a demonstration platform, and walks you step-by-step through the process of creating hardware and software for Nios II embedded processor systems.

Documentation Library

For complete documentation on the Nios II processor, on the Windows Start menu, point to All Programs, Altera, Nios II EDS <version>, and then click Nios II <version> Documentation. For details on the Nios II IDE, launch the IDE and open the Nios II IDE help system.